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Introduction

1 Introduction

This chapter provides a brief overview of the scope of this manual, what
eXDI is, our MAJIC eXDI Driver / Plugln, and which Windows CE
environments are supported.

About this Manual

Note:

What is eXDI?

Note:

This is the user manual for the Embedded Performance eXDI driver and
Plugln. It is aimed at end-users who intend to use the MAJIC with
Microsoft’s Platform Builder IDE.

Except where explicitly stated to the contrary, the term MAJIC refers to all
models of MAJIC (references to MAJIC™Y and MAJIC™™ refer to those
respective models).

eXDI is Microsoft’s Extended Debug Interface. This interface allows EPI
to create a driver that is used by Microsoft’s Platform Builder’s IDE to
provide full access to MAJIC’s hardware-based debug services. In
addition, we offer an eXDI Plugln which provides extended GUI-based
debug services not available within Platform Builder itself. A good
example of this is Target CPU Trace services.

Window CE 5.x implements two eXDI interfaces (eXDI1 and eXDI2).
This MAJIC eXDI driver is an eXDI1 driver. At the of this writing eXDI2
API documentation is not available to third parties.

Windows CE requires installation on Windows 2000, XP or later,
consequently the driver has the same restrictions as Windows CE.
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Supported Windows CE Environments

At the time of this writing MAJIC eXDI supports the following Windows
CE-based development environments. If you don’t see your Windows CE-
based environment listed, please contact EPI for the latest information.
Note that this manual is targeted at users of Windows CE 5.0. There are
quite a few differences in the operation of 5.0 versus previous version of
Platform Builder. Thus the previous version of this manual (MAJIC
Windows CE .Net eXDI User’s Manual) is also provided and should be
used by users of Platform Builder 3.x or 4.x.

Windows CE .5.0 Full Support
Windows CE .Net 4.x Full Support

Windows CE 3.0 Access to symbols and source code within the MAJIC eXDI Monitor
Window and Plugln are not supported.

Related Documentation

Microsoft Windows CE Online Help Describes the Extended Debug Interface (eXDI)
supported by Windows CE 5.x.

MAJIC User’s Manual See Tab section in EPI Development Tools for
MAIJIC: Revision 2.01, Dated: November 2002 or
later.

MDI for MAJIC User’s Manual See Tab section in EPI Development Tools for

MAIJIC: Documents usage of EPI’s Meta Debug
Interface. Revision 1.2, Dated: March 2003 or later.
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Notational Conventions

Normal

Bold face

Italic

Header/Note

Arial Font

The following conventions are used in the syntax descriptions of this
manual.

Just Normal Text.
Identifies characters that must be entered exactly as shown.

Indicates a general category of input described in detail in the command
operand's section.

Appearing to the left of a text block, indicates a step boundary or special
note.

Indicates text appearing on the screen, e.g. menus or dialogs.
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2 Installation

Getting Started

Step 1:

Step 2:

Step 3:

Step 4:

Step 5:

This chapter describes how to install and configure the MAJIC eXDI Driver
and Plugln provided by EPI.

Install the Microsoft Windows CE .Net software package. It is important to
do this before installing the EPI Tools package because our installer will
update registry entries created by the Microsoft Installer. If you installed
the Microsoft Windows CE .Net software package first then run the
“install.bat” utility found in the C:\Program Files\EPITOOLS\
EDTx2x\exdi\ directory after installing the EPI Development Tools (EDT)
package to update the registry entries.

Install the EPI Development Tools package (EDT). Verify that you have a
directory named “exdi” under the installation root of the EDT package. If
you do not, then you have not correctly installed the eXDI Driver software.

Install any third-party software, such as the Accelent Systems software, or
your Board Support Package (BSP).

Review the MAJIC Quick Start Guide — Hardware as a starting point for
setup and configuration of your MAJIC probe. If you don’t have a printed
MAJIC Quick Start Guide then please refer to the digital version in the
CD’s manuals directory. Review the MAJIC Quick Start Guide —
Software section and then see either step 5 or step 6 for more specifics on
running the MAJIC Setup Wizard.

For flash programming with the EPI Flash Programming Utility you will
need to set up a shortcut for MONICE, EPI’s underlying command line
interface. With this shortcut you can flash your bootloader.

1. Run the MAJIC Setup Wizard found in the Start menu under Start->
Programs-> EPI Tools - EDTx-> MAJIC Setup Wizard.

2. At the first screen select Next.

3. Under Choose your Debugger select MONICE and click Go.
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Step 6:

4. Choose a Project Name and enter a description of your project. Now
click [Next].

5. Select your Processor Type and Select your Target’'s Endian, click
[Next].

6. Choose your connection type. If it is your first time connecting to the
MAIJIC, you must select the Serial port. If you are not connected to a
network and would like to use Ethernet (cross-over cable) you must choose
an IP address. See the MAJIC User’'s Manual for more information.

7. In the Configuration Files window choose Use Existing Startup
Files. Browse to the samples directory and choose a sample directory that
does not have an _wince extension. The settings for WinCE will interfere
with Flash programming. If there are no sample files for your platform then
choose Create New Startup File and Adjust Default Properties.

8. In the next screen choose Reference the existing startup files from
their location.

9. Click Perform Actions, and then Done.

A shortcut for MONICE should pop up on your desktop. Power up your
target and the MAJIC, then double-click on the desktop shortcut. Verify
that you are able to connect to your target board, make sure that you see the
message “JTAG connection established” in red letters. Use this connection
in the future for flash programming. See the flash programming utility
manual in the C:\Program Files\EPITOOLS\EDTx2x\manuals directory
for more information.

To use Platform Builder you will need to setup the appropriate
configuration files for your target board. To do this:

1. Run the MAJIC Setup Wizard found in the Start menu under

Start-> Programs-> EPI Tools - EDTx-> MAJIC Setup Wizard.

2. In the first screen click [Next].

3. Under Choose your Debugger select Platform Builder (WinCE) and
click [Go].

4. Choose a Project Name and Enter a one line description of your
project, select [Next].

5. Select your Processor Type and Select your Target's Endian,
choose [Next].

6. Choose your connection type. If it is your first time connecting to the
MAUIJIC you must select Serial port. If you are not connected to a network
and would like to use Ethernet (cross-over cable) you must choose IP
address. See the MAJIC User’s Manual for more information.

7. In the Configuration Files window, choose Use Existing Startup
Files. Browse to the samples directory and choose a sample directory that
matches your target type. If there are no sample files for your platform
then choose Create New Startup File and Adjust Default Properties. If
you are using an XScale reference platform be sure to choose a folder that
has a _wince extension. If there are no sample files for your XScale target
with a _wince extension contact support@epitools.com.

9. In the next screen click Perform Actions, and then Done.

Power up your target and the MAJIC, then browse to the C:\Program
Files\EPITOOLS\EDTA22a\eXDI directory and double-click on the
majic_exdi_driver.exe file. This should launch the eXDI interface and
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Step 7:

connect to the target successfully.

If you have not already read your MAJIC User’s Manual now is the time.
This can be found in digital format in the EPI Documentation Index. See
your EPI Tools EDTx start menu for details.

Updating the Registry

Note:

Normally, the Windows registry is setup when you install the EPI Tools
from a production CD. If you received your software as a zip file or you
are manually moving your EPI Tools installation directory around, then you
need to run the script . /exdi/install.bat to update the registry
settings. For example:

DOS> cd exdi
DOS> install

Microsoft’s Platform Builder should already installed before you install the
EPI Tools CD or run this install batch file. If for some reason you install
Platform builder after installing the EPI Tools CD, then simply run this
install batch file again.

Test Your Driver Setup/Installation

First, make sure Platform Builder is not running. From the Windows Start
menu select Start -> Programs -> EPI Tools - EDTx ->
Majic_Exdi_Plugln. This launches the Plugln as shown below:

2% MAJIC eXDI Plugln (ARM Arch) = E) =]
File Wiew Debug Help

iy
= p
[ %4
[ t MAJIC
Can el obe

Now select the menu item Debug -> Connect to MAJIC Probe. If your
setup is configured correctly, then the driver starts and the MAJIC eXDI
Monitor Window pops up as shown below. If it does not start correctly,
repeat step 6 in the “Getting Started” section above.

[ MAJIC eXDI Monitor: (=]
MAJIC eXDI Monitor Version 1.6 il

Loading MDI DLL c:spkgiedta2icsbinsmdi.dll
felected Device Info: HEcale PEA27@ via majicd
Motification from the target:

Target power detected on UREF

fiuto JTAG detection process detected 1 TAP
WTAG connection established

Installing Debug Handler for PEA27Vx:

Debugy handler Installed

Connected to target system: XScale_PHA278 via majicd
HON> =
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Note: The Driver may pop up a configuration selection dialog if you have
multiple configurations defined in your MDI configuration file. If so,
simply select the appropriate configuration. The contents of this window
will vary slightly, but you should get a valid connection established and a
MON> prompt.

Now from the Plugln Menu select Debug -> Disconnect from MAJIC
Probe. This disconnects the Plugln from the driver and if no other
applications are connect to the Driver then the driver shuts down.

eXDI Files

The following files relating to MAJIC eXDI support are provided in the
directory where your EPI software is installed.

./exdi/majic_exdi driver.exe
The MAIJIC eXDI Driver.

./exdi/majic_exdi_plugin.exe
The MAJIC eXDI Plugln.

./exdi/eXdi_ epips.dll
A supporting DLL used by the driver.

./exdi/install.bat
A DOS batch file that creates or updates eXDI driver and Platform Builder
registry entries. Note that normally all the needed registry work is done
when you install the tools from the CD. You will need to run the
install.bat file if you manually moved the “exdi” installation
directory or you are installing an engineering version.

./exdi/uninstall.bat
Un-installs registry entries setup by install.bat.

./manuals/MAJIC_eXDI_UserManual.pdf
This manual. Installing the manuals is optional, if you did not install the
manuals then this file can still be accessed directly from the . /manuals
directory on the installation CD.

The following files are not eXDI specific, they are needed regardless of
whether you are using an EPI debugger or a third-party debugger.

./mdi/.. MDI installation tree. MDI is used by eXDI to talk to your MAJIC probe.
Refer to the MDI for MAJIC User’s Manual for details
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3 Configuring Platform Builder

This chapter explains the steps needed to configure Platform Builder to
utilize your MAJIC probe for hardware debug. The steps outlined here are
for Windows CE 5.x. Similar, but slightly different steps are used by prior
version of Windows CE. In either case, the best source of documentation
on this aspect is the actual Platform Builders documentation.

Configuring your Platform Builder Project to use MAJIC

Step 1:

Step 2:

Launch Platform Builder and select in the workspace/project you wish to
configure. You probably want to be using a debug build of your project, but
that is not required to utilize MAJIC. The debug build will offer you a
view of non-optimized code, while the Release build will be optimized.
Note that these configuration changes are workspace-specific and you will
need to repeat them for each workspace/project configuration which you
wish to enable for debug with MAJIC.

Configure Platform Builder to use a hardware debug probe. Select the
menu item: Target -> Conectivty Options. This brings a dialog as shown
below. Select MAJIC eXDI Driver in the Debugger drop down list as
shown below.

@) Target Device Connectivity Options B

Device Configuration
Add Device Taiget Device:
|CE Device LJ

Delete Device

Download:

Service Configuration |Ethamet LJ Settings

Hernel Service Map [ MAINSTMEI4ET |

Core Service Settincs
Transpart;

|Ethamet LJ Settings

[ MAINSTHE34ET )

Service Status

Debugger:

[MaJIC DI Driver =l

Apply | LClose Help
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Step 3:

Step 4:

At the time of this writing eXDI is not a choice for either Transport or
Download, but it is expected to become available at a later date for one or
both of them. Generally, the values for these two options are not specific to
MAIJIC usage and should be configured per your board/bsp documentation.
Typically they are both configured for Ethernet when EBOOT is
used/installed as the bootloader.

Click the [OK] button to apply and close the dialog.

Next, we need to configure Platform Builder not to include the software-
based debug kernel in your CE image build. Select the menu item Platform
-> Settings.... Now select the Build Options tab and uncheck the Enable
Kernel Debugger check box and click the [OK] button.

Platform Settings

LConfiguration:
Intel Fs27x Dew Platform:aR by 4|_Debug d

General | Locale Errviranmert | Custam Build Actions | [l 41 |

Build options:
Buffer tracked events in RaM [IMGOSCAPTURE=1)
w| Enable CE Target Contral Support [SYSGEN_SHELL=1]
w/| Enable Eboot Space in Memory [IMGEBOOT=1)
Enable Event Tracking Duwing Boot IMGCELOGEMABLE=1)
w| Enable Full Kernel Mode [no IMGHMOTALLKMODE=1)]
Enable Kemel Debugger [ho IMGHODEBUGGER=1)
Enable KITL [no IMGHOKITL=1)
Enable Profiling (IMGPROFILER=1]
Flush tracked events to Release Directary (IMGAUTOFLUSH=1]
Run-time Image Can be Larger than 32 ME [IMGRAME4=1]
Usze ¥COPY inztead of links to populate release directary (BUILDREL_L
Wiite Bun-time Image to Flazh Memaory (IMGFLASH=1)

LY

[ 0K H Cancel ]

By default PB’s Thread and Process Windows communicate with the target
WinCE OS at run-time to gather the data for the window contents.
Normally this means these Windows won’t when the target is stopped via
MAIJIC. Setting a build environment variable enables stopped at a
breakpoint or e this data gather to occur over the eXDI interface when the
target is stopped an build variable needs to be added. Select the
Environment Tab in the Platform Settings dialog (shown below).

Platform Settings

Lonfiguration:
Intel F=a27x Dew Platform:aF by 4|_Debug d

General | Locale | Euid Options || Cusztom Build Actions | I 41 * |

Environment variables:

Y arigble W alue
IMGHDSTUBE 1

Mew... H Edit... H Remove ]

[ Ok H Cancel ]
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Click the [New...] button and add the IMGHDSTUB environment variable.
This causes the hardware debug stub to be included in your kernel image at
build time, which in turn allows the Thread and Process Windows to
function when stopped. Note that this setup step is critical to allowing
application level debug.

Environment Yariable

W ariable name:
IMGHDSTUE

Y ariable walue:
1

()4 ] [ Cancel

Step 5: Rebuild your Windows CE image. Menu item: Build OS -> Build and
Sysgen.
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4 Using the Driver

This chapter demonstrates usage of the MAJIC eXDI Driver. It is assumed
the user has successfully followed the steps in Chapters 2 and 3 to install
the Driver and configure Platform Builder to utilize it.

Debugging a Downloaded Image

Step 1:

Step 2:

For this example we are using an Intel” XScale™ Micro-Architecture
(PXA27x)-based platform with a working EBOOT installed in flash and
Platform Builder set up for download of a new Windows CE image
(nk.exe) via EBOOT’s download facility.

First make sure you are disconnected from the target and no Platform
Builder target services are running. Do this by selecting the menu item
Target -> Detach Device or the Target toolbar button 2.

Starting the eXDI Driver and resetting the target system:

In previous version of PB you could simple use the Build menu or toolbar
Go button to start. If you do this in 5.x or later, it does start the driver, but
it does not start the background download process. Instead, you must now
select the menu item Target -> Attach Device or the g in the Target

Toolbar. The old method will start, but the background download process
will not be activated. After selecting Target -> Attach Device, PB
launches or connects up to an already-running MAJIC eXDI Driver. The
MAIJIC eXDI Monitor Window pops up as shown below and the target is
reset and stopped at the reset address.

3 MAJIC eXDI Monitor: - o x|
AJIC eXDI Monitor Uersion 1.6 :EJ

oading MDI DLL c:spkgsedta2icsbinsmdi._d11
elected Device Info: HScale PEAZ278 via majicd
otification from the target:

arget power detected on UREF

uto JTAG detection process detected 1 TAP
TAG connection estabhlished

Installing Debug Handler for PHAZ27x:

ebug handler Installed

onnected to target system: HScale PHEAZ78 via majicd

ON> _:J

Platform Builder then takes a few seconds to initialize, read target memory
to establish the state of the target OS (if any), and then open up a
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disassembly window at the current PC location (example shown below).

Disassembly El

= 00000000 b nooolooo A

oooooond andeq rl, r0. x0 (=)

goooooog andeqg 0, 0, x0 .

| nooooooc andeq 0, 0. z0 I+
< *

Step 3: Starting the EBOOT Image:
Now we are ready to start the boot code. Select the menu item Debug ->
Go or the Toolbar Go button [ j]. EBOOT starts and proceeds to sync up
with PB and send out a ready to download message. PB then proceeds to
download the WinCE image. After completing EBOOT then jumps into the
WinCE to start it running

Note that before you select the GO operation you can insert breakpoints
within your downloaded image.

At any time you can interrupt this process by simple selecting the menu
item Debug -> Break or [ button. You can also set a breakpoint either
while stopped or while the image is executing.

Step 4: Updating Module/Symbol Information:
After stopping, if you suspect new modules or DLLs have been loaded, you
need to tell Platform Builder to refresh its modules list. This is done by
selecting the menu item: Target -> CE Modules and Symbols or E
button which opens the Modules and Symbols window. If this window was
already open, then you must tell it to refresh its data. This is done with the
window’s refresh % button.

If the only module listed is nk.exe, then either you’ve stopped before any
other modules or DLLs were loaded, or your WinCE kernel data format
doesn’t match the format expect by Platform Builders OsAxs.dll module.

Step 6: Ending a Debug Session:
Be sure when ending a debug session that you not only end your debug
session via the menu item Debug -> Stop or [ button, but also end the
Platform Builder target services via Target -> Detach Device or &y
button.

The closing of the MAJIC eXDI Monitor Window may take few moments
as it cleans up various services. Note that the Driver and Window will
remain active if you have the PlugIn running and actively connected to the
Driver.
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Debugging a Boot Image

Step 1:

Step 2:

Step 3:

Step 4:

Step 5:

For this example we are using an Intel” XScale™ Micro-Architecture
(PXA27x)-based platform with EBOOT installed in flash as the image to
debug. It could also be a full WinCE image.

It is important to make sure your EBOOT ROM image matches your
debugging image. This involves building your eboot.bin image file and
burning it into flash ROM. Please refer to your Platform Builder
documentation on building EBOOT for details.

After building EBOOT and burning in your ROM image, select into
Platform Builder the just built eboot.bin as your workspace. Note that this
is not the eboot.bin from your flat release directory, but instead the file
from the path MS refers to as:

9% TARGETPLATROOT% t ar get \ % TGTCPU% 9%\l NCEDEBUGY
If you need further help on this aspect please consult your Platform Builder
documentation or contact Microsoft product support.

Make sure you are disconnected from the target and no Platform Builder
target services are running. Do this by selecting the menu item Target ->
Detach Device or the Target toolbar button Zp.

You can either just begin single-stepping into the ROM or use a hardware
breakpoint near the location in EBOOT you wish to stop and begin real
debugging. For example to stop in main(), first find the location of your
EBOOT’s main function. The file/location may vary based on your BSP.
For the development board used here, it is mai n. ¢ in the directory C
C:\WINCES500\PLATFORM\MAINSTONEINSRC\BOOTLOADER\EB
OOT. Select in this file and find the start of the code area for the main
function(). Set a breakpoint at this location by clicking the cursor on the
referenced line and selecting the breakpoint &M button. Now select the
menu item Edit -> Breakpoints, right-click on the breakpoint you wish to
change and select Properties. In the dialog that pops up click the the
[Hardware] button to bring up a dialog for changing the kind of breakpoint
used. Select the Hardware radio button, and then click the [OK] button.

Breakpoint Selection
® Hardware
O Softuare [ Concel ]
= Cancel
P | Concel |

Finally, click the Breakpoints dialogs [OK] button and you are ready to
start executing.

Next, select the menu item Target -> Attach Device or the Target toolbar
%EI button. This launches or connects-up to an already-running MAJIC

eXDI driver. The Driver Monitor Window pops up as shown below, and
the target is reset and stopped.
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Step 6:

3 MAJIC eXDI Monitor: -0 x|
AJIC eXDI Monitor Uersion 1.6 ﬂ

oading MDI DLL c:\pkghedtaZ2icsbinsmdi.dll
elected Device Info: HScale_PXA278 via majic4d
otification from the target:

arget power detected on UREF

uto JIAG detection process detected 1 TAP
TAG connection estahlished

Installing Debug Handler for PEA27x:

ebug handler Installed

onnected to target system: XScale PREA27A via majic4d

ON> LI

Platform Builder takes a few seconds to initialize, read target memory to
establish the state of the target OS (if any), and then open up a disassembly
window at the current PC location (example shown below).

Disassembly El
= 00000000 b gooolooo @

noooonod andeq rl, 0, r0

goooooog andeqg 0, 0, x0

0000000C  andeq 0. Tl 0 v
[ T [»]

Now we are ready to start the boot code. Select the menu item Debug ->
Go or the Toolbar Go button [4]. The target should then break in main.c
similar to below. You can now start debugging.

@ Disassembly =)=
77 BootloaderHain(): w
€ 80024585 EBOODE43 bl |Boot loaderdain (8
78
79 A7 Should never get here.
a0: s =
g1 - .
£00244 [E] main.c B[]
g2 /7 Bootloader main routine. i
83: A
[il i wold mainivolid) =
{

4 Common boot loader (blcommon) main routine.
s
L =2 Boot loaderMain( ) ;

E]

A7 Shrild newer aet here

L] )
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Breakpoint Issues

The Problem:

The Answer:

Hard Coded Break:

Step 1:

Step 2:

Note:

Pitfalls:

I’'m trying to debug my ROM based bootloader or WinCE image, but my
initial breakpoint doesn’t get hit. Why is this?

By default, when MAJIC connects to a target system it reset the target
processor and waits at the reset address for the user to set breakpoints and
tell the target to go. EBOOT and WinCE images in ROM typically do a
number of things that can cause problems for an initial software breakpoint.
In some cases, the run-time image copies itself from ROM to RAM, thus
removing the software breakpoint in RAM set at go time. Bootloaders and
WinCE images also typically setup the MMU at run-time, thus the address
that the breakpoints was set at go time either doesn’t exist or is not going to
be the same memory as it is after the MMU is setup.

Fortunately, MAJIC supports hardware breakpoints which allow you work-
around these issues. Simply right-click on your breakpoint in the
Breakpoint List Window and select Properties. Now select the
Hardware button and click the Hardware radio button.

There is also another way to cause your program to hit a breakpoint. The
steps below outline how you can embed a software breakpoint directly in
your code.

Edit the source code where you wish to set your breakpoint and add the
following code above the line you wish to stop on. The specific code value
you use depends upon your target CPU.

For XScale/ARM V5 chips:
__emit(0xE12cec7e); // breakpoint
For MIPS chips:
__emit(0x70cece3f); // breakpoint

Recompile your code and run it. Upon hitting the breakpoint, notice that
the program counter (pc register) has been adjusted to the instruction after
your hard-coded breakpoint. This allows you to easily continue execution
after stopping.

One way to better manage this breakpoint issue is to hard-code your
breakpoint at your module’s entry point. Once you stop at the breakpoint,
you can then decide to set a normal software breakpoint where ever you
need one.

If you run your system without the eXDI driver in place your hard-coded
breakpoint will cause your system to hang up. You’ll need to disable the
breakpoint in your code and recompile to run without the MAJIC eXDI
driver loaded.
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Using the eXDI Monitor Window

Trace Setup and
Display

The eXDI Driver’s Monitor Window contains a subset of our low-level
Monice (MON) debugger command interface. It contains a rich set of
commands to examine memory and registers, display and control trace
acquisition, and configure your MAJIC probe. Please refer to the MAJIC
User’s Manual for details on the MON command language.

For some CPUs, trace setup is as easy as enabling trace capture via MON’s
+t € command. Others require setup of what kinds of things to trace, when
to stop etc. The description of this is beyond the scope of this manual.
Please refer to your MAJIC User’s Manual chapter on trace control.

Example: Below is a screen shot of enabling trace and displaying the result.
Note that between the enable (+t €) and the display trace (dt ) command
we went back to Platform Builder’s menu and told the target Go [ ]| for a
few seconds and then selected the Break | button. This allowes MAJIC
to capture some trace data for display. Note that the amount of data
captured is dependent on your MAJIC model and target CPU. For the CPU
used here, the results can vary with the execution stream, but typically
about 1000 instructions are captured.

MON>+te
Trace mode is: Execution tracing
MON>dt, i
Processing raw trace acquisition...
127 raw trace frames retrieved
961 frames selected for upload
INSTRUCTION MODE TRACE DISPLAY
T
FRAME P LOCATION VALUE DESCRIPTION
—————— +
943 0 800c37b4: e58d7000 STR r7, [sp]
944 0 800c37b8: e58d4004 STR rd, [sp, #4]
945 0 800c37bc: da00006b BLE 0x800C3970 ; OEMIdle+0Oxlec
946 0 800c37cO: e59f01d4 LDR r0, 0x800C399C
947 0 800c37c4: e5901000 LDR rl, [r0]
948 0 800c37c8: e3510000 cCMP rl, #0
949 0 800c37cc: 1a000067 BNE 0x800C3970 ; OEMIdle+0Oxlec
950 0 800c37d0: e59f01c0 LDR r0, 0x800C3998
951 0 800c37d4: e5901000 LDR rl, [r0]
952 0 800c37d8: e3510000 cCMP rl, #0
953 0 800c37dc: 0a000005 BEQ 0x800C37F8 ; OEMIdle+0x74
954 0 800c37f8: eb000223 BL 0x800C408C ; PerfCountSinceTick
955 PerfCountSinceTick:
0 800c408c: e59f0020 LDR r0,0x800C40B4
956 0 800c4090: e3al024a6 MOV r2, #0xA6000000
957 0 800c4094: e3822503 ORR r2,r2,#0xC00000
958 0 800c4098: e5901000 LDR rl, [r0]
959 0 800c409c: 5920000 LDR r0, [r2]
960 0 800c40a0: e3al3ee6 MOV r3, #0xE60
961 0 800c40a4: e3833006 ORR r3,r3,#6
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Note:

Coprocessor and

Peripheral Register

Access

The trace information above can also be viewed via the Plugln’s Trace
Display Window which provides a GUI-based interface and source line
information instead of just symbols. Please see the next chapter for details
on using the Plugln.

Platform Builder’s IDE only provides access to a subset of CPU registers.
MON supports access to a full set of CPU and peripheral registers. This is
configured via startup files and can be customized by users. For full details
on configuration and usage consult the MAJIC User’s Manual. Below are
some simple examples for the Intel PXA250 demonstrating the power of
this feature.

In this screen shot we told the debugger to display, via the Display Word
(dw) command, a bank of peripheral registers for an on-chip serial port.
This peripheral has four registers starting at the physical memory address
41000000. To the right of the register’s value display is a field breakdown
of the individual bits/fields. Multi-bit fields are displayed as

fi el dname=val and single-bit fields are displayed in uppercase for 1
and lowercase for value 0.

MON>dw sscr0 ssitr

sscr0:

41000000:P 00000000 (scr=0 sse ecs frf=0 dss=0)

sscrl:

41000004:P 00000000 (strf efwr rft=0 tft=0 sph spo lbm tie rie)

SsSsr:

41000008:P 0000F004 (rfl=f tfl=0 ror rfs tfs bsy rne TNF)

ssitr:

4100000c:P 00000000 (tror trfs ttfs)

The registers can also be edited via simple commands. The Enter Word
(ew) command (shown below) modifys a field within a register.

MON>ew sscr0.dss=2

MON>dw sscr0

sscr0:

41000000:P 00000002 (scr=0 sse ecs frf=0 dss=2)

Memory Access

Platform Builder’s is limited to examining Virtual Memory, although
developers often find it necessary to reach down inside and look at physical
memory. MON commands can be used to examine such memory. For
example: We know that the boot code on ARM targets start at address 0,
but in many virtual memory-based applications the boot code is no longer
visible once you have booted up. By using a physical memory address
qualifier (: p) in MON’s Display Word command we can see this memory.
The “L 4~ after the address says to list a range of four words and the “, i ”
says to display the words as instructions.
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MON>dw O:p L 4,1

00000000:P eal0003fe B 0x1000 ;
00000004:P 00000000 ANDEQ r0,r0,r0
00000008:P 00000000 ANDEQ r0,r0,r0
0000000c:P 00000000 ANDEQ r0,r0,r0

Option There are many configuration options available for your MAJIC probe.
fi . This aspect is covered in detail within the MAJIC User’s Manual. As a

Con 1gur ation simple example here we cover the interesting case of using the Vector
Catch feature to stop when an exce?tion occurs. Note that is example is
specific to ARM and Intel® XScale M based cores.

By default, the Vector Catch option is configured off for the Windows CE
environment. We chose this default because we envision most users in a
complex environment, like Windows CE, will want the default behavior of
their OS when an exception does occur. MON’s Display Option and Enter
Option commands allow us to modify the default settings.

MON>dov vector catch

EO vector catch = 0x0 // Default: 0x0

// Valid values: 0x0 - Ox1ff

//

// Determines which exception conditions are detected and control passed

// back to the debugger. The bits correspond as follows:

// Bit# Field Cause

// 0 0x001 Reset

// 1 0x002 Undefined Instruction

// 2 0x004 Software Interupt

// 3 0x008 Prefetch Abort

// 4 0x010 Data Abort

// 5 0x020 Address Exception

// 6  0x040 IRQ

/7 7 0x080 FIQ

// 8 0x100 Error

MON>eo vector catch = 0x2
As you can see from the Enter Option command above, we configured the
probe so as to stop execution when an Undefined Instruction exception
occurs.

Shutting Down The Driver automatically shuts down as soon as all the connections to it are
closed. Unless you manually started the Driver there should be no need to
manually shutdown the driver via the window close button. Note that both
Platform Builder and the Plugln are clients of the Driver, so both need to be
disconnected (if connected).
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5 Using the Plugln

This chapter shows you the capabilities and usage of the MAJIC eXDI

Plugln.

Launching the Plugln

The Plugln can be started from the Platform Builder’s menu item Tools ->
Plug In -> MAJIC eXDI Plugin. The PlugIn’s main window pops up as

shown below:

£ MAJIC eXDI Plugin (ARM Arch) ==
File Wiew Debug Help

=l b

Ready

Now select the menu item Debug -> Connect to MAJIC Probe. If your
setup is configured correctly the Driver starts up and brings up the MAJIC
eXDI Monitor Window (example shown below). Note that when bringing

up the Plugln the MAJIC eXDI Monitor Window is typically already
running. In such case, the Plugln just connects to the existing driver
instance.

B3 MAJIC eXDI Monitor:

M=

AJIC eXDI Monitor Version 1.6

oading MDI DLL c:\pkg“edta2ic:sbin“mdi.dll
elected Device Info: XScale PXAZ78 via majicd
otification from the target:

arget power detected on UREF

uto JTAG detection process detected 1 TAP
TAG connection estabhlished

Installing Debug Handler for PRA27x:

ebug handler Installed

onnected to target system: XScale PHAZ278 via majic4

ON > j
Note that some of the PlugIn Window’s buttons become enabled after
successful connection.
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Using the Trace Window

Enabling Trace:

Note:

Trace Display Modes

Instr

Mixed

One of the Plugln’s most useful features is the GUI-based Trace
Display Window. It provides a convenient scrollable access to any ‘Sj
captured trace data in your MAJIC probe. Use the Plugln’s menu =
item View -> Trace Display or the button shown to the right to open the
Trace Window.

You can then use the [Display] button to get the trace data from the Driver
and display it. However, this assumes you have actually captured some
data. To do that you may need to Enable Trace via the menu item

Debug -> Trace Enable or the button show to the right, followed &y
by a run / break sequence to actually capture some trace from a real

target run.

Some processors with advanced trace features require the setup of a trace
specification to determine what is to be captured. Please refer to your

MAJIC User’s Manual for details on trace setup.

Below is a sample Trace Display window:

: Trace Display - 981 frames x|
Frame | Addr | R A | Walue | Description |ﬂ
970 800c3810 =38e=006 CER lr. lr. #6
971 B00c3814 =0832000 ADD r2. ri.rl
972 B00c3818 =0830192  UHMOLL =x0.r3.r2.rl
973 B00c381c =1a01523 HOW rl,r3, 15K #10
974 B00c3820 =0000=%91 | HUL r0.rl. 1lr
cenidle. c#133: CurlSec += dwCount;
975 B00c3824 =59b1000 LDRE rl,[rll]
976 B00c3828 =0420000 SUE r0.r2. r0
977 B00c382c =0814523 ADD rd4, rl r3.L5E #10
978 B00c3830 =5LE8go000, STR rl, [rd]
ocenidle . c#l4l: if {{int) (dwldleMSec -= CurMSec - dwFrevHS
979 B00c3834 =0450004  SUE r0.r5.rd
980 B00c3838 =5Eb4000 STR rd, [rll] —
981 B00c383c 0807006 ADD r?.r0. rh -|
[Fpisplay || =instr ST Mixed ZSData = Source

The Window title bar shows the total number of captured frames of trace
data and the toolbar indicates the current display mode.

The Trace Display Window’s toolbar allows you update the trace data and
select the display mode. The available modes are listed below.

Displays valid instruction accesses in disassembled form. If the address of
an instruction corresponds to a source line, then the source line is displayed
first on its own line. If no source line exists, but a symbolic label
corresponds to the address, then the symbol is displayed first on its own
line.

Combination of Instr and Data display modes.
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Data

Source

Displays valid data accesses in a formatted form. The R/W column
displays the kind of access that occurred and the width is implied by the
Value field. Note that many CPUs do not support data tracing.

Displays only the source or labels associated with valid instruction frames.
This allows you to concisely see your execution flow from a source code
point of view.

Trace filters and searching are also available via MON commands. Please
refer to your MAJIC User’s Manual for details.

Miscellaneous Features

Symbol Reload

Break

Always On Top

Symbol/Source information is automatically loaded from Platform Builder
upon the first reference. However, because of the dynamic nature of the
Windows CE OS new programs might get loaded (or even reloaded at new
addresses). In such a case, you must manually tell the Driver to reload
symbols from Platform Builder. This is accomplished via the menu item
Debug -> Reload Symbols or the toolbar button to the right. E

The Plugln provides a break button that mirrors the behavior of the break
button in Platform Builder. Normally there is no reason to use this button,
but some times the Platform Builder user interface is so busy starting and
stopping the processor for various reasons that it never acts upon a break
request. The extra break provided here gives you an easy way to halt the
processor if such a case arises. The break facility can used via the menu

item Debug -> Break or the button to the right. I

Many times it can be inconvenient to switch back and forth between the
Plugln and Platform Builder Windows. The Plugln has a feature to allow it
to always be a top level window. This allows you to maximize your
Platform Builder Window and still see and operate with your Plugln
Windows. The feature is enabled via the menu item: View -> Always On
Top.

The Settings Window

The Settings Window provides control of Driver/Plugln File Logging and
the Auto Start Execution feature. The Settings Window can be launched
via the toolbar and the menu item View -> Settings.
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Auto Start Execution

Disable PB OS
Memory Search

Note:

Auto Detect PB
Workspace/Bin File

Capturing a Debug
Log Session

Some users may find that when starting up the Driver/Probe they don’t need
the added step of halting at the reset address, but would rather just auto-
start execution. This behavior can be accomplished by clicking the
checkbox below and selecting the [OK] button.

Settings

Logging Optiong
| Sesszion Logging I
¥ I

Log File Mame:

tizc Ophions
i

| Disable PB's 05 Memaory Search

v Auto Detect PB Workspace/Bin File

2
Cancel

When debugging non WinCE images (bootloaders, etc), PB’s compiler can
produce images that trick PB into thinking it should search for WinCE
kernel information on the target. This significantly slows down debugging
of the target. Enabling this option tells PB not to do the search.

The first release of PB 5.0 does not utilize this option, and at the time of
this writing MS has not yet made an update available.

If enabled this option allow you to manually reference the executable (.bin)
file that is to be used by the PlugIn and eXDI driver to read symbol and
source information from.

If you encounter problems that you think related your MAJIC Probe or
software we may ask you to capture a debug log session so we can
investigate the issue. The log will capture all the communication between
your Probe, Driver, Plugln and Platform Builder. Below are details of how
to enable the log capture.

Before you begin a debug session from Platform Builder, start the MAJIC
eXDI Plugln by selecting Platform Builders menu Tools -> Plug In ->
MAJIC eXDlI Plugln.
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From the PlugIn Toolbar select the Settings ICON or menu item View ->
Settings. This brings up the following window:

Settings

Logging Options

[v Seszion Logging v
v XDl Call Lagging [ MDI Call Logging

Laog File Name:

C:Amajic_exdi_driver.log

Mizc Options
[ Auto Start Execution

| Dizable PB's 05 Memary Search

v Auto Detect PB Waorkspace/Bin File

Biowee1 |
Cancel

Select the Session Logging check-box. This enables the items contained
in the session logging group. Check the eXDI Call Logging and the
Time Stamp Log Entries check boxes followed by selecting the [OK]
button. We suggest leaving the MDI Call Logging unchecked unless EPI
has asked you to enable it. The Log File Name defaults to a location on
the Drive C:. You can change this to any filename and/or location you
wish. All the Driver captured log information is stored in this file.

You can now shutdown the Plugln if you wish since it will communicate
this setup information to the MAJIC eXDI Driver.

Note: The Plugln itself also has a log file that is enabled via the Session Logging
checkbox. The log file name is maj i ¢_exdi _pl ugi n. | og and it is put
in the same directory referenced in the Log File Name edit box. If the
issue you are trying to capture involves interactions with the Plugln then
this file can also be relevant.

Session Capture: If you enable Session Logging and leave the rest of the check boxes
within Session Logging unchecked what is captured is all the information

sent to the eXDI Driver Monitor Window. You might find this useful for
recording the output that occurs in this window.

Disconnecting the Plugln

To disconnect the Plugln from the Driver simply select the menu item

=S

Revision MAIJIC Windows CE 5.x eXDI User’s Guide 23




Using the Plugln

Debug -> Disconnect from MAJIC probe or the button shown to the
right.
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6 Support/Contact Information

EPI Support

EMail: support @pitools.com
Internet: wWww. epi t ool s. com
Telephone: 408 957- 0350

Microsoft Support

Please note that EPI support is specific to the EPI distributed tools, which
does not include Platform Builder. Please contact Microsoft’s Support
department via the web address below and click on the support link for help
with Platform Builder and Win CE .NET specific questions.

htt p: // ww. nBwep. com
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